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•	Unpacking

Unpacking	and	assembly

•	In-Shop	Assembly

1.  Remove all items from the shipping containers. Inspect the cabinet 
exterior units for damage. Pay special attention to cabinet edges, seams 
and corners.

2.  The door keys are either located in the picture chute, on the booth’s side 
or on the curtain rails. Remove the keys.

3.  The service door is on one side of the Printer unit. Unlock and open the 
service door. Inspect the cabinet interior for signs of damage. Check all 
major assemblies to assure that they mount securely.

4.  Check to see that cable connectors are correctly secured. Don’t force con-
nectors. They’re keyed to fit in only one location. Bent pins and reversed 
connections may damage your photo booth and void the warranty.

5.  Check to see that all booth electronic devices plug into the power strip 
inside the booth. Make sure that none of the power plugs are loose.

6.  Check the wiring harnesses for disconnected plugs, frayed wires, shorts or 
other abnormalities.

•  The photo booth ships on a skid. 

•  The major components are located in the 
main cabinet.

English Français

The photo booth is very heavy. It also con-
tains fragile parts. Movement of photo   booth 
requires at least two people.

Le photomaton est très lourd.  Il contient 
aussi des pièces fragiles.  Il faut avoir deux 
personnes pour bouger le photomaton.

English Français

Avoid overloading booth power support cir-
cuit. Never plug a nonbooth circuit, tool or ap-
pliance into the booth power strip.

Évitez de surcharger le circuit d’alimentation 
électrique de photomaton. Ne branchez 
jamais dans la prise électrique : un circuit, un 
outil, ou un appareil qui ne fait pas partie du 
photomaton.

FOREIGN POWER. The photo booth oper-
ates on 120VAC, 60 Hz power. To operate 
this booth on different power specifications, 
you must install a line-conversion transform-
er. Without this transformer, the photo booth 
may malfunction, start a fire, or cause per-
sonal injury.

PUISSANCE ÉTRANGÈRE. Le photomaton 
fonctionne en 120 volts c.a., puissance de 
60 Hz.  Pour utiliser ce photomaton avec les 
spécifications de puissance différentes, il faut 
installer un transformateur de conversion.  
Sans ce transformateur, le photomaton peut 
mal fonctionner, prendre feu, ou causer 
dommage à la personne.

http://www.faceplacephoto.com
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•	Warnings	&	Notices

Safety

•  To assure safe operation, observe specifications, notices and cautions in this document. 
We accept no responsibility for damage or injuries arising from improper use of this prod-
uct.

•  Prevent electrical shocks and equipment damage! Before connecting or disconnecting the 
cables or changing the paper, disconnect booth AC power. Switching off power at the 
booth switch still allows power to enter the booth. You may still be exposed to live current.

•  Prevent shock hazards! Only plug the AC power cord into a grounded, three-prong AC 
outlet. Never defeat or remove the power plug ground prong.

•  Don’t touch exposed wires or moving parts. For example…

•  Power supply modules 

•  The IO board

•  Touching these parts could cause a laceration, shock, or other injury. A printer malfunction 
and data loss might also result.

•  Never touch the thermal print head, or head area. The print head operates at an extremely 
HOT temperature. Touching it might cause a burn or other injury.

•  Every time you replenish paper, remove the residual paper from the machine. (Scrap pa-
per from vended photo strips). Otherwise, paper debris may cause a printer jam, or, even 
poses a fire hazard.

•  When cleaning the head, follow the directions in the Mitsubishi manual. Never use cotton, 
wool or other fabric swabs, because they leave lint behind. This lint poses a fire hazard.

•  The printer contains an automatic time-out mechanism. This timer protects the print head 
against overheating, smoke, or fire. Excess power or voltage during a time interval causes 
printer shutdown. Improper use of this product might cause overheating, smoke and fire. 

•  Printer protective circuitry regulates the length of time under power. Printer circuits also 
regulate power applied to the print head and motor. If you replace or tamper with printer 
circuitry, components might overheat, smoke or burn.

•  Only use Mitsubishi FP2000 Media (Apple Industries part # FP2000) in the printers. Use of 
other media will cause the photo booth not to work and may cause poor image quality and 
printer damage. Using other media will void your warranty.

WARNINGS

English
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•  The print head and associated parts are very delicate.

•  Touching the print head or head area might cause a printer malfunction or data loss. 

•  Avoid contacting the print head area with metal objects such as tweezers or screw-
drivers. 

•  Touching the print head or associated parts may deposit dirt. Dirt can degrade the 
print head heating element. Dirt deposits can pick up a charge and promote static 
electric damage.

•  Avoid static electricity! While servicing the print head or printed circuit boards (PCB), use 
proper body grounding procedures. 

•  If condensation occurs, don’t turn on the photo booth. Otherwise, you might damage the 
printer and/or the electronics.

•  Make sure that no dust collects on the media. Never operate booth components in areas 
containing dust, dirt, and metallic powder. Contaminants affect print quality, camera opera-
tion, circuit board reliability and DBV operation.

•  Never pull the media out while the printer is printing. Pulling the paper in this way can dam-
age both the media and the delicate print head.

•  Follow media-loading instructions precisely. Also, if instructions do not  mention a particular 
operation, then do not do it. Otherwise, you might jam or damage the print head, heating 
element and gears.

•  Pour assurer la sécurité de fonctionnement, observez les spécifications, les avis, et les 
avertissements dans ce document. Nous n’acceptons pas de responsabilité pour des 
dommages ou des blessures qui se produisent des usages abusifs de ce produit.

•  Prévenez des décharges électriques et le dommage à l’équipement ! Avant de connecter ou 
déconnecter les câbles ou de changer le papier, déconnectez l’adaptateur d’alimentation 
c.a. du photomaton. En coupant le courant électrique par l’interrupteur du photomaton, le 
courant électrique toujours entre le photomaton.  On peut être exposé du courant de la 
ligne.

•  Prévenez les dangers de choc ! Seulement met la corde de puissance c.a. dans une prise 
électrique c.a. qui est adéquatement mise à la terre. Ne dégradez jamais ou n’enlever 
jamais la broche de mise à la terre de la fiche.

•  Ne touchez pas les fils exposés ou les pièces mobiles.  Par exemple…

•  Les modules d’alimentation

•  Le panneau IO

•  En touchant ces pièces, il est possible de causer une lacération, un choc, ou des autres 
blessures.  Un autre résultat peut être un mal fonctionnement d’imprimante ou la perte de 
données.

ATTENTION

Français
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•  Ne touchez jamais la tête d’impression thermique ou la région de tête.  La tête d’impression 
fonctionne à une température très CHAUDE.   En la touchant, il est possible de causer une 
brûlure ou d’autres blessures.

•  Chaque fois vous remettez du papier, enlevez le papier résiduel de la machine. (Papier 
brouillon des bandes vendues).  Sinon, débris de papier pose un risque d’incendie.

•  En nettoyant la tête, suivez les directions dans le manuel Mitsubishi. N’utilisez jamais 
des écouvillons de coton, de laine, ou d’autres tissues, parce qu’ils laissent tombés des 
peluches.  Les peluches posent un risque d’incendie.

•  L’imprimante contient un mécanisme de temps imparti automatique.  La minuterie protège 
du sur chauffage, de la fumée, et du feu de la tête d’impression.  Une surabondance de 
pouvoir ou voltage, pendant une durée, cause une fermeture d’imprimante. Mal usage de 
ce produit peut causer sur chauffage, fumée, et feu.

•  Les circuits protectifs d’imprimante réglementent la durée sous pouvoir. Les circuits 
d’imprimante aussi réglementent le pouvoir appliqué à la tête d’impression et moteur.  Si 
vous remplacez ou manipulez les circuits d’imprimante, composants pourront sur chauffer, 
fumer, ou brûler.

•  Seulement utilisez média Mitsubishi FP2000 (pièce d’Apple Industries n° FP2000) dans 
les imprimantes. Usage d’autre média causera le mal fonctionnement du photomaton et 
peut causer la mauvaise qualité des images et du dommage à l’imprimante. Usage d’autre 
média annulera votre garantie.

•  La tête d’impression et les composants associés sont très délicats.

•  En touchant ces pièces, il est possible de causer le mal fonctionnement d’imprimante 
ou la perte des données.

•  Évitez de toucher la tête d’impression avec des objets métalliques comme les 
pinces à épiler ou les tournevis.

•  En touchant la tête d’impression et les composants associés, on peut déposer des 
saletés.  Des saletés peuvent dégrader l’élément chauffant de la tête d’impression.  
Des dépôts de saletés peuvent accumuler des charges électriques et causer du 
dommage de charges statiques.

•  Évitez des charges statiques ! En révisant la tête d’impression ou les planches de circuits 
imprimés, utilisez les mesures de mise en terre correctes.

•  Si condensation se produit, n’allumez pas le photomaton. Sinon, vous pouvez endom-
mager l’imprimante et/ou les électroniques.

•   Assurez que le média ne retienne pas de poussière.  N’opérez jamais les composantes du 
photomaton dans les endroits qui contiennent de la poussière et de la poudre métallique. 
Des contaminants affectent la qualité d’impression, l’opération d’appareil photo, la fiabilité 
de la carte de circuit, et l’opération du validateur de l’argent.

•  N’extrairez jamais le média pendant que l’imprimante imprime. L’extrait du papier dans ce 
manieur peut endommager le média et la tête d’impression délicate. 

•  Suivez les directions de chargement précisément. Aussi, si les directions ne contiennent 
pas une opération en particulier, ne le faites pas. Autrement, vous pouvez bloquer ou en-
dommager la tête d’impression, l’élément chauffant et les engrenages.

http://www.faceplacephoto.com
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•  This book uses the abbreviation “DBV” for “dollar bill validator.”

•  This equipment has been tested. It complies with Class A device limits, pursuant to Part 
15 of FCC rules. These limits provide reasonable protection against interference when 
operating the equipment in a commercial environment. To ensure Class A FCC limit com-
pliance, use only shielded cables with this unit. This equipment generates, uses, and can 
radiate radio frequency energy. Install and use this equipment according to the instruction 
manual. Otherwise, this equipment may cause harmful interference to radio communica-
tions. However, these measures do not guarantee interference prevention in a particular 
installation.

•  Operation of this equipment in a residential area is likely to cause harmful interference. At 
your own expense, you must correct interference. By turning this equipment off and on, 
you can determine if it interferes with radio or television reception. If it does, then the FCC 
encourages you to try to correct interference. Use one or more of following measures:

•  Reorient or relocate the receiving antenna.

•  Increase separation between the equipment and receiver.

•  Connect the equipment and receiver to different outlets or circuits.

•  Consult a dealer or experienced technician for help.

•  Operation under Part 15 of the FCC Rules imposes further restrictions:

•  The photo booth must accept any interference received. Such received interfer-
ence may cause undesired operation.

•  Modifications to this equipment could void your authority to operate it.

•  Apple Industries Inc. continuously improves products and services. Specifications may 
change without notice.

NOTICE

http://www.faceplacephoto.com
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Key Point:  To enter configuration mode, simply tap the 6:00 
position repeatedly.  A keypad will appear in the upper left 
hand corner of the screen.

When you turn on your PhotoBooth for the first time, it will automatically 
load the feature mode of your PhotoBooth called “attract mode.”  (“Attract 
mode” is the only software mode accessible to PhotoBooth customers). 

At any point while “attract mode” is playing, operators can quickly enter a 
secure Configuration and Adjustment Utility by simply tapping the six o’clock 
position repeatedly, displaying a keypad in the upper left hand corner of the 
screen.

With Apple’s innovative Smile 2.0 software, operators can quickly navigate through 
the onscreen guide to change the software configurations with the touch of a button.  
Smile 2.0 allows operators to:

•	Entering	the	configuration	and	adjustment	utility

Configuration

◊  Store photographs on a USB Flash Drive. 

◊  Capture customer email addresses for marketing purposes.

◊  Automated revenue reports.

◊  Change print and share prices.

◊  Customize available programs and functionality.

◊  Email meter reports.

◊  Manipulate software timing delays.

◊  And much more….

http://www.faceplacephoto.com
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Service Credits:

Allows a service technician to test the machine by granting service credits.

* Default Access Code: 1-4-4-1, followed by “OK”

Current Meter Report:

Provides a current “soft” reading of the meter.  Allows operators/techni-
cians to print or email the report.

* Default Access Code: 5-4-3-2-1, followed by “OK”

• All three access codes can be changed by the 
operator by entering the Configuration Utility and 
pressing “Security” as shown below.

For security purposes, once the keypad has appeared, operators are 
prompted to input an access code to enter one of three different modes 
within configuration utility:

Configuration:

Allows full access to the configuration and adjustment utility.

* Default Access Code: 1-2-3-4-5, followed by “OK”

http://www.faceplacephoto.com
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Navigating the Configuration Utility is designed to be user friendly, 
utilizing main-menu tabs across the top (Configuration, Programs, Reports, 
Timing and Upsell, Help) and sub-menu tabs down the left hand side (these 
change based on which menu item you have selected along the top menu).  
Operators can determine which menu is selected by examining the tabs 
highlighted in white.  Unselected tabs remain in light blue.

•	Navigating	the	Configuration	and	Adjustment	Utility

•  The operator should change the three ac-
cess codes from the default codes for se-
curity purposes.

Once the desired access code is entered and “OK” selected, operators will 
notice a brief delay (approximately 3-5 seconds) for the Configuration and 
Adjustment Utility to load.  The screen will display the Windows desktop 
during this brief delay.

Key Point:  Entering the Configuration and Adjustment Utility 
requires operators to enter an access code followed by the 
“OK” button. 

http://www.faceplacephoto.com
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Key Point:  Use your finger to toggle settings in the Configura-
tion Utility ON and OFF

Key Point:  Share functionality requires a working internet con-
nection properly configured with your booth.

•  See additional details in the Network Con-
nectivity Section.

The following features can be configured by pressing the Configuration tab 
and selecting the appropriate sub-menu:

Configuration Tab

General Settings:

This sub-menu allows operators to customize photo strips and save 
pictures to a USB Flash Drive or within a folder on the hard drive itself. 

“Refer to the Logo Manual for details on using the custom logos.”

 The General Settings sub-menu also allows operators to capture email 
addresses entered by the PhotoBooth user when using Share functionality.  
These email addresses will be saved in a file on the PhotoBooth and can be 
sent to the operator by pressing the Email Captured Emails button under the 
Online Alert Tab.  (Note:  This will send an email to the email address(es) 
entered in Email Reports To sub-menu under the Reports tab).

http://www.faceplacephoto.com


Section - Configuration

Apple Industries Inc. - Service Manual www.faceplacephoto.com Page 8

Pricing:

Toggle Free Play on and off and adjust prices for additional prints and 
Share (Facebook, Twitter, Email) using this option.

Volume:

Controls the Theme volume (music) and Voice volume.  Operators can also 
configure the Theme and Voice balance, although this is not recommended.

Duplicate Prints:

Saves an additional print file with each photo saved to the USB Flash 
Drive.  If enabled, the operator can press this button and re-print all photos 
within that print file.

The Programs Tab is used to activate or deactivate Smile 2.0 print/share 
customizations.  Operators have the ability to add or remove options or 
rearrange the order in which customers can select the type of photo strip or 
4 x 6 photographs.

Programs Tab

Location Settings:

Enter a Location Name  (Note:  the “Location Name” becomes the name 
of the folder on the USB Flash Drive, DO NOT INCLUDE SPACES AT THE 
END OF LOCATION NAME), Location Type, Operator Name, Location Split, 
and Machine Date/Time.  This sub-menu can also be used by operators to 
configure the monetary split by operators/locations in generated reports.  
Additional information on meter reports can be found later on in this manual.

Security:

As referenced above, this sub-menu is used to configure access codes for 
your PhotoBooth.

Camera Settings:

Operators can configure the “zoom” of the camera using this function.  
Other options within this sub-menu are considered “advanced settings” for 
troubleshooting purposes and should not be configured unless directed by an 
Apple technician.

Payment Methods:

Toggles money acceptor and credit card reader on/off, controls pulse per 
currency unit.

http://www.faceplacephoto.com


Section - Configuration

Apple Industries Inc. - Service Manual www.faceplacephoto.com Page 9

Key Point:  Recording times for “Video Messages” can be 
changed to a maximum of 60 seconds. (Note:  Saving video 
messages to a USB Flash Drive requires the appropriate amount 
of disk space, which should be monitored by operators.

Sub-Menu Options:

Fun Borders, Classic, Face Replacements, Holiday Borders, Passport Style, 
Post Cards, Video Message, Hair Styles, Email, Facebook, and Twitter.

Key Point:  Print and Share options can be toggled ON and OFF 
and configured using the “Programs” menu.

http://www.faceplacephoto.com
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Key Point:  Operators can also add custom “Message Signature” 
to Facebook. Customers who post prints to Facebook will au-
tomatically receive the text in “Message Signature” along with 
the print. Operators can also enable batch uploads to Facebook 
from this menu.

Key Point:  Adding a custom “Message Signature” offers a great 
marketing tool to operators. Customers who “Email” prints will 
automatically receive the text in “Message Signature” at the 
bottom of the email they receive.

Facebook – Operators can toggle Facebook on/off from this sub-menu. Clients 
can also provide their Facebook usernames and passwords and press the 
“Store Credentials for Later” button.  This will allow the operator to upload the 
photos to customers’ Facebook pages at a later time without security concerns.

http://www.faceplacephoto.com
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Key Point:  To turn the Upsell feature off, operators should 
toggle it under the “Timing and Upsell Tab”,  “Checkout” 
sub-menu.
Key Point:  Operators can limit the maximum number of upsell 
prints allowed from this menu.

This menu allows operators to automatically send usage reports to the 
email address of their choice. Operators can customize frequency and add 
additional recipients. For more advanced operators, an FTP server can be 
used and audit reports enabled.

Reports Tab

Operators can configure inactivity warnings and timeout occurrenc-
es throughout “Attract Mode” of Smile 2.0 software. Different warning 
and timeout points can be configured for the Checkout, Shopping Cart, 
Sharing, Approval, Take Picture, and Select Product features within Smile 
2.0. Operators can also toggle the Share functionality within the Checkout 
sub-menu of the Windows Tab.

Timing and Upsell Tab

http://www.faceplacephoto.com
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Operator will always be able to enter the Configuration Utility even if 
they have incorrectly configured something preventing the Application from 
starting up.  This would allow for an Operator to enter the Configuration 
Utility and Reset Configuration to Default to get their Booth.

We have added new features to make reading and interpreting the data 
in the Meter Reports much more simple.  Collectors should now press the 
“Collect and Print” or “Collect without Print” Buttons while making a collec-
tion.  This will automatically send a Meter Report to the designated email 
addresses during the collection (Note:  Email addresses can be entered 
and modified under the Reports tab).  Also, the full credit card reader serial 
number is now listed for easier setup with our partner credit card processing 
company, USA Technologies.

•	Configuration	Safe	Mode

•	Meter	reports

Operators can return to Default configurations and reset the soft meter 
report to zero from this menu (Note:  Operators’ current Access Codes will 
return to the Default Access Codes).

Help Tab

http://www.faceplacephoto.com
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The 4x6 Watermark is an operator loaded watermark, which is overlaid 
on a 4x6 Photo.  It is important the logo is kept small, since it is overlaid 
directly on top of the photo.  If it is too big, it will interfere with the aes-
thetics of the photo.  Depending on the orientation of the 4x6, the Portrait 
(Figure 2) or Landscape (Figure 3) Watermark will be used.

4x6 Wartermarks
Figure 1

Figure 2

Figure 3

•	What	are	they?

4th	Frame	Logo,	4th	Frame	Coupon	&	4x6	Watermarks

The 4th Frame Logo (Figure 1) is an operator loaded logo 
that will be placed on the PhotoStrip in the 4th Frame.  When 
enabled and a PhotoStrip is selected by the customer, 3 
images will be captured instead of the usual 4 images.  The 
4th image will be replaced with the Logo.  The 4th Frame Logo 
is not placed over any image which is why it should not have 
an alpha channel (transparency).

4th Frame Logo

The 4th Frame Coupon is an operator loaded coupon that 
will be placed on the PhotoStrip in the 4th Frame of the 2nd 
PhotoStrip. The 4th Frame Coupon shares the same speci-
fications as the 4th Frame Logo with the exception that it is 
only printed on a single strip. If you have both a 4th Frame 
Logo and a 4th Frame Coupon enabled, each strip will have 
a different 4th Frame, one with the Logo and one with the 
Coupon. The 4th Frame Coupon is not placed over any image 
which is why it should not have an alpha channel (trans-
parency). When a user shares their photo, the PhotoStrip 
Coupon will not be on the shared image.

4th Frame Coupon (Promotion)

http://www.faceplacephoto.com
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4x6 Landscape Watermark

4x6 Portrait Watermark

The image requirements are as follows for setting up 4th Frame Logos/
Coupon and 4x6 Watermarks:

Logo/Coupon & Watermark Image Requirements

4th Frame Logo 4th Frame Coupon 4x6 Landscape
Watermark

4x6 Portrait
Watermark

File Type PNG PNG PNG PNG

Color RGB RGB RGB RGB

Transparency Layer N/A N/A 1 1

Bits per Channel 8 8 8 8

Total Channels 3(RGB) 3(RGB) 4(RGB+Alpha) 4(RGB+Alpha)

Total Bits 24 24 32 32

Resolution 1500 X 1000 1500 X 1000 1500 X 1000 1000 X 1500

Filename photostrip.png photostrip_coupon.png landscape.png portrait.png

Filename 2 photostrip2.png photostrip_coupon2.png N/A N/A

Filename 3 photostrip3.png photostrip_coupon3.png N/A N/A

Filename 4 photostrip4.png photostrip_coupon4.png N/A N/A

4th Frame

http://www.faceplacephoto.com
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1.  Access Configuration Mode.

2.  Touch Configuration.

3.  Touch Branding Settings.

4.  Use the ON/OFF Sliders to select the Options for the 4th Frame Logo, 4th 
Frame Coupons & 4x6 Watermarks. (Figure 4) 

Figure 4

To create and/or modify a 4th Frame Logo/Coupon and/or 4x6 Watermark 
you will need to use a Photo Editing Software on a computer other than the 
PhotoBooth to create the necessary image files that meet the image require-
ments listed above.

Microsoft Windows comes with a built in Photo Editor, Microsoft 
Paint, which can be used for simple logos.  PaintBrush, a free basic 
Photo Editor for a Mac based computer can be downloaded at 
http://paintbrush.sourceforge.net.

For best results when creating complicated Logos and Watermarks on both 
Windows and Mac, a professional photo editing tool should be used, such as 
Adobe Photoshop (http://www.adobe.com/products/photoshopfamily.html) 
or GIMP (http://www.gimp.org).

4th Frame Logo/Coupon & 4x6 Watermark Creation

Enabling/Disabling  4th Frame Logo/Coupon & 4x6 Watermark

We also give the ability for an operator to load up to 4 Photostrip Logos and 4 Photostrip 
Coupons (See Filename 2, Filename 3, & Filename 4 specifications above) that can be used in 
one of the following options:  
 Off – Turned Off 
 Single – A Single Logo is used 
 Cycle – The application cycles through the enabled logos in order during each usage.  
 Random – The application cycles through each enabled logo randomly during each usage.

5.  Touch Save and Exit to Save Configuration Changes.

http://www.faceplacephoto.com
http://paintbrush.sourceforge.net
http://www.adobe.com/products/photoshopfamily.html
http://www.gimp.org
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1.  Copy Theme Song to the USB Flash Drive (not in a folder).

2.  Access Configuration Mode

3.  Insert USB Flash Drive into PhotoBooth Computer USB Port and wait 15 
seconds

4.  Exit Configuration Mode

5.  During the Program Startup Process, the application will load any found 
files and overwrite any that are currently on the PhotoBooth.

6.  Remove USB Flash Drive if not using to save images after PhotoBooth Ap-
plication has started.

The Theme Song can be changed in the same manner as the Logos/
Coupon/Watermarks.  Any MP3 that is to be used should be named, “Theme 
Song.mp3” (No Quotes), and placed on the USB Flash Drive.  You can load 
the Logos/Coupon/Watermarks either together or separately with the MP3 
but the same process is followed.

•	Theme	Song

•  Previous Theme Song will be overwritten 
with any found on the USB Flash Drive 
during the startup process.

•  If the files are not named correctly or are 
in a folder on the USB Flash Drive then 
they will not load properly.

1.  Copy Logo, Coupon & Watermark Files to the USB Flash Drive (not in a 
folder).

2.  Access Configuration Mode

3.  Insert USB Flash Drive into PhotoBooth Computer USB Port and wait 15 
seconds

4.  Exit Configuration Mode

5.  During the Program Startup Process, the application will load any found 
files and overwrite any that are currently on the PhotoBooth.

6.  Remove USB Flash Drive if not using to save images after PhotoBooth 
Application has started.

Loading 4th Frame Logo, 4th Frame Coupon & 4x6 Watermark to Booth

•  Previous Logos/Coupon/Watermarks will 
be overwritten with any found on the USB 
Flash Drive during the startup process.

•  If the files are not named correctly or are 
in a folder on the USB Flash Drive then 
they will not load properly.

http://www.faceplacephoto.com
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Fun Borders are Picture Frames that are displayed when a customer selects
the Fun Border Program within the Smile 2.0 Software. An example of an
outputted 4x6 Fun Border is below:

Custom Fun Borders can be created to give your Photo Booths a personal 
feeling for your locations.  Custom Borders should be created in sets of 4 as 
a Photo Strip requires 4 Borders to be selected and are typically put together 
into themed Strips.  A single border can be used more than once in a Strip 
but this may not be ideal for your customers.

• What Are They?

Custom Fun Borders Setup 

• Fun Borders Image Requirements
The image requirements are as follows for custom Fun Borders:

Border Foreground SampleImage

File Type PNG

Color RGB

Transparency Layer 1

Bits Per Channel 8

Total Channels 4(RGB+Alpha)

Total Bits 32

Resolution 1500 X 1000

Purpose
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Border Foreground SampleImage

File Type PNG

Color RGB

Transparency Layer 1

Bits Per Channel 8

Total Channels 4(RGB+Alpha)

Total Bits 32

Resolution 1500 X 1000

Purpose

• Fun Border Creation 

To create and/or modify a Fun Border you will need to use a Photo Editing

Software on a computer other than the PhotoBooth to create the necessary

image files that meet the image requirements listed above. The Transparent

Area of the image will be where the user will be placed within the Fun Border.

Microsoft Windows comes with a built in Photo Editor, Microsoft

Paint, which can be used for simple logos. PaintBrush, a free basic

Photo Editor for a Mac based computer can be downloaded at

http://paintbrush.sourceforge.net.

For best results when creating complicated Logos and Watermarks on both

Windows and Mac, a professional photo editing tool should be used, such as

Adobe Photoshop (http://www.adobe.com/products/photoshopfamily.html)

or GIMP (http://www.gimp.org).
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• Loading Custom Borders

1.  Copy Custom Borders PNG files onto a USB Flash Drive to Load into Photo 
Booth.

2.  Connect a USB Keyboard & USB Mouse to the Front USB Ports of the Photo 
Booth CPU.

3.  Connect USB Flash Drive with Custom Borders into Front USB Port of the Photo 
Booth CPU.

4.  At any point while “Attract Mode” is playing, tap the six o’clock position on the 
monitor.

5.  Hit the ESC or ALT + F4 Key on the Keyboard to close the Photo Booth Appli-
cation.

6.  Open Windows Explorer by Selecting Start->My Computer.
7.  Double Click E Drive to Explore USB Flash Drive.

8.  Copy all Custom Borders PNG files to C:\PHOTOBOOTH\Images\Borders\

9.  Open Notepad by Selecting Start->All Programs->Accessories->Notepad.
10.  Open Border Configuration File by choosing File->Open and opening 
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The Border Configuration File is where you setup the various Photo Strips 
by putting the filenames of the scenes for each strip.  The configuration file 
is an XML file, you can learn more about XML file basics, here:

 http://www.w3schools.com/xml/xml_syntax.asp.

Each set must be configured in groups of 4 images, within an 
<OverlayImageGroup> tag.  The OverlayImages are than set within a nested 
<OverlayImages> tag.  Than each image within the set is spelled out within 
a <OverlayImage> tag where the details for the image are spelled out.

The Photo Strips will be displayed within our Application in the order the 
groups of strips are ordered from top to bottom. If you would like your strips 
to be displayed first, they should be put towards the top of the .XML file

NOTE: The first few lines MUST not be removed: 
<CombinableImageFiles> 
<Directory>borders</Directory> 
<OverlayImageGroups> 

NOTE: The last few lines MUST not be removed: 

</OverlayImageGroups> 
</CombinableImageFiles

NOTE: If the proper formatting of this file is not maintained and 
filenames point to files not located on the Photo Booth, the Photo 
Booth Application will not start up properly until you fix any issues 
within this file or restore your Photo Booth using a Restore Disk.

Save the file after you have made your modifications. Disconnect the 
Keyboard, Mouse & USB Flash Drive. Restart the Photo Booth. 

Example Photo Strip Setup
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The Smile 2.0 Photo Booth Attract Mode Configuration Tool is a tool that 
has been developed by Apple Industries to allow Operators to quickly and 
easily switch between the Standard Face Place Attract Video and custom 
image slideshow.

Required Hardware:

◊  USB Flash Drive

◊  USB Keyboard

◊  USB Mouse

In the near future this will be included on the Recovery DVD as a standard 
option, but at this time it requires the installation of the tool.  

Please download the correct file from our Face Place Website by visiting 
one of the following links and saving the file onto a USB Flash Drive. 

Inside Booth:

http://www.faceplacephoto.com/downloads/Smile2.0_Inside_Attract_Mode_Tool.msi

Pix Place Booth:

http://www.faceplacephoto.com/downloads/Smile2.0_Outside_Attract_Mode_Tool.msi

•	Introduction

•	Install	Attract	Mode	Tool	on	Smile	2.0	Photo	Booth

•	Downloading	Installation	File

Attract	Mode	Configuration	Tool

1.  Shut Down Photo Booth.

2.  Connect the Keyboard & Mouse to Photo Booth CPU.

3.  Connect USB Flash Drive to Photo Booth CPU.

4.  Power on the Photo Booth and Allow Photo Booth to fully Startup.

5.  Close the Photo Booth Application by clicking the Message Area and hitting 
ALT+F4 on a Keyboard.

6.  Open Windows Explorer by Selecting Start->My Computer.
7.  Double Click E Drive to Explore USB Flash Drive.

8.  Double Click the Installation File you downloaded to run Installer.

9.  The Installer will automatically install and close itself very quickly.  The 
Attract Mode Tool is now installed.

http://www.faceplacephoto.com
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Attract Mode Image

File Type PNG or JPG

Transparency Layer N/A

Resolution (Inside)* 1280 x 864

Resolution (Outside)* 1080 x 1695

The images will be displayed in filename order in the slideshow. (If you 
want the images to display in a particular order, ensure the filenames utilize 
numbers such as 0001_, 0002, etc…).

For example, if I had 3 images that I wanted to display in order, I could 
utilize the following naming scheme to ensure they are displayed as 
intended:

On the USB Flash Drive create a New Folder and name it Attract_Images. 
Copy all images that will be used for the Attract Mode Slideshow into the 
folder named Attract_Images.  (E.g.  E:\Attract_Images\).

*The resolutions above ensure that the images are displayed full screen.  
Smaller sizes can be used, but they will be displayed with a black border 
around the image or off the screen if they are larger than the allowed resolu-
tions.

•	Preparing	Images	for	Slideshow

•	Ordering	Images	for	Slideshow

•	Adding	Slideshow	Images	onto	USB	Flash	Drive

0001_Introduction.png

0002_Family.png

0003_Bye.png

The image requirements are as follows for images that will be used in the 
Attract Mode Slideshow:

http://www.faceplacephoto.com
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•	Enabling	Image	Slideshow

1.  Shut Down Photo Booth.

2.  Connect the Keyboard & Mouse to Photo Booth CPU.

3.  Connect USB Flash Drive, (with pre-loaded images), into the Photo Booth 
CPU. 
 
NOTE: It is important that if you have any other USB Flash Drives 
connected to the Photo Booth CPU that they be removed at this 
time.  You should only have a single USB Flash Drive connected to 
the Photo Booth CPU at one time to ensure that Drive Letter As-
signments do not get altered. 

4.  Power on the Photo Booth and Allow Photo Booth to fully Startup.

5.  Close the Photo Booth Application by clicking the Message Area and hitting 
ALT+F4 on a Keyboard.

6.  Select Tools Folder on Desktop.

7.  Double Click Photo Booth Attract Mode Configuration. (Shortcut to 
Launch Face Place Photo Booth Attract Mode Configuration Tool). 

(*Note: If you did not save the images to E:\Attract_Images\, you will 
need to select Browse and select the folder where your images are 
saved). 

8.  Select Enable Image Slideshow and follow all prompts to enable the 
Image Slideshow.

9.  Once you receive the confirmation window that the Image Slideshow has 
been loaded select OK. (The Attract Mode Configuration Tool will close).

http://www.faceplacephoto.com
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10.  Remove USB Flash Drive.

11.  Restart the Photo Booth Application by Double Clicking the Logo on the 
Desktop or by restarting the Photo Booth.

12.  You should now see the Image Slideshow in the Attract Mode.

•	Enabling	Default	Video	Attract	Mode

1.  Shut Down Photo Booth.

2.  Connect a Keyboard & Mouse to Photo Booth CPU.

3.  Power on the Photo Booth and Allow Photo Booth to fully Startup.

4.  Close the Photo Booth Application by clicking the Message Area and hitting 
ALT+F4 on a Keyboard.

5.  Select Tools Folder on Desktop.

6.  Double Click Photo Booth Attract Mode Configuration. (Shortcut to 
Launch Face Place Photo Booth Attract Mode Configuration Tool).

7.  Select Enable Default Video and follow all prompts to enable the Image 
Slideshow.

8.  Once you receive the confirmation window that the Video has been loaded 
select OK. (The Attract Mode Configuration Tool will close).

9.  Restart the Photo Booth Application by Double Clicking the Logo on the 
Desktop or by restarting the Photo Booth.

10.  You should now see the Default Video in the Attract Mode.

http://www.faceplacephoto.com
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The Meter Report (also called Collections Report) is a powerful tool. It 
keeps track of statistics such as: 

The image below is an example of what the Meter Report looks like on the 
Smile 2.0 Photo Booth monitor.

•	What	is	it?

Meter	Reports

◊  Number of prints purchased.

◊  How many times photos and videos are shared.

◊  How much cash and credit your booth has made since the last 
report.

◊  Which styles and themes customers choose. 

◊  Amount of paper remaining in the printer.

http://www.faceplacephoto.com
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Operator Name

Name of the operator. See Configuration section to check how to edit it.

Operator Phone

Phone number for the operator.  See Configuration section to check how to 
edit it.

Location Name

Name of the location. See Configuration section to check how to edit it.

Location Type

Type of Location. See Configuration section to check how to edit it.

Report #

Will increase each time report is RESET.

Date/Time

Start / End times of the current report number.

Photobooth Software

Current version of Smile 2.0 application.

Printer ID Number

Unique ID number of printer. This number may be needed for servicing 
your printer.

Freeplay Prints

Number of photos printed while booth is on FreePlay during the Start/End 
time of the report.

In order to access the Meter Report, the application needs to be on the 
Attraction Screen. This is when the video is playing and the START button 
is visible. Once on the Attraction Screen, touch the middle section of the 
bottom of the screen, where the text is cycling, 5 times and keypad will 
pop-up on the screen. The default password for the Meter Report is 54321. 
We recommend changing it to a more secure password. See Configura-
tion section to check how to change it. Once you enter your password, the 
desktop will become visible and the Meter Report will be shown in a moment.

When determining how much money should be in the Cash Box and your 
Credit Card Account, you will need to look at the CURRENT values of CASH 
EARNED and CREDIT EARNED:

•	How	do	I	view	it?

•	How	do	I	interpret	it?

•	Description
System Summary

http://www.faceplacephoto.com
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Initial Print Revenue

Total money used to purchase the primary photo. This does not include any 
Upsell purchases.

Upsell Revenue

Total money used to purchase any additional prints or shares during Upsell.

Cash Earned

Total cash entered into the Dollar Bill Validator during the Start/End time of 
the report.

Credit Earned

Total money swiped in the Credit Card Reader.

Total Earned

Sum of Cash Earned and Credit Earned. Total amount of money earned 
during the Start/End time of the report.

Location Split (%)

Amount of money owed to the location based on the percent entered and 
Total Earned. See Configuration Guide to check how to change the per-
centage. This provides a quick calculation for the current report.

Operator Split (%)

Amount of money the operator keeps based on the percent entered and 
Total Earned. This percentage is not set in Configuration Mode but is calcu-
lated by subtracting the Location Split Percentage from 100%.

Freeplay Shares

Number of times a photo or video is shared via email, Facebook, or Twitter 
while booth is on FreePlay during the Start/End time of the report.

Paid Prints

Number of photos purchased during the Start/End time of the report.

Paid Shares

Number of times a purchased photo or video is shared via email, Facebook, 
or Twitter during the Start/End time of the report.

Total Errors

Number of errors that have occurred during the Start/End time of the 
report.

Current Paper Remainig

Number of prints allowed based on available paper in the printer.

Service Credits

Number of credits used for testing while booth is not on FreePlay. To 
access Service Credits menu, pull up the number pad in Attract mode and 
enter the appropriate password. The default password is 1441.

Revenue Summary

http://www.faceplacephoto.com
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Button Controls

Touch to access Detailed Report screen. This has no effect on the 
current report.

Touch to email current report to email address(es) entered in Con-
figuration. See Configuration Guide to check how to add or edit 
addresses. This has no effect on the current report.

Touch to print current report on 4x6 paper. This will reset all current 
report statistics and increase the Report # by 1.

*Note: The printed report may require more than one 4x6 paper, depending on the 
number of sessions in the Daily Summary.

Touch to exit the Meter Report and reset all current report statis-
tics and increase the Report # by 1. Once the Meter Report is exited, 
Attract Mode will play automatically.

Touch to exit the Meter Report and save all current report statistics. 
This button should be used when just evaluating the statistics without 
performing a collection. Once the Meter Report is exited, Attract mode 
will play automatically.

Daily Summary

Start/End

Provides a detailed statistics in a specific time range when the booth is 
powered on. It creates a new range each day at midnight as well as if the 
machine is powered down for than 5 minutes. This lets the operator know if 
the booth was shut down and for how long. It also provides analysis on how 
busy the booth is on a particular day.

Qty

Quantity – Provides the number of prints and shares for the time range.

Money In

Provides total cash and credit used during the time range.

Stock

Provides amount of paper remaining at the END time of the time range.

•  Lifetime information only gets removed if a Reset of 
the meter is done in Configuration mode.

http://www.faceplacephoto.com
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The Detailed Report displays the System Summary, as found in the Meter 
Report, along with an in depth analysis of each photo taken. This tool allows 
the operator to see which products are being utilized. The image below is an 
example of what the Detailed Report looks like on the Smile 2.0 Photo Booth 
monitor.

•	Detailed	Report

http://www.faceplacephoto.com
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•  Lifetime information only gets removed if 
a Reset of the meter is done in Configura-
tion mode.

Pricing

Lifetime

Product Type

Lists the type of photo by describing the Program used, if it was a Photo-
strip or 4x6, and how it was vended (whether it was printed or shared via 
email, Facebook or Twitter).

Price

Cost of the product.

Quantity

Number of times the specific product was purchased during the time of the 
report.

Money In

Amount of money the specific product made during the time of the report.

Product Type

Lists the type of photo by describing the Program used, if it was a Photo-
strip or 4x6, and how it was vended.

Quantity

Number of times the specific product was purchased during the lifetime of 
the booth.

http://www.faceplacephoto.com
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1.  Wired – A Wired Internet Connection requires an Ethernet Cable with 
Internet Access at the location to be run into the PhotoBooth and 
connected directly to the PhotoBooth computer.  A Wired Internet Connec-
tion will be the most reliable of the three connection options and will be 
the easiest to install and configure.

2.  WiFi as WAN - A WiFi Network available at the location can be used to 
provide Internet Access to the PhotoBooth.  The reliability of this connec-
tion will depend on a number of factors including the Signal Strength of the 
WiFi Network.  

3.  4G/3G Wireless Broadband – A 4G/3G Wireless Broadband USB 
Modem (Air Card) can be used to provide Internet Access to the Photo-
Booth.  The reliability of this connection will depend on a number of factors 
including the Signal Strength of the Broadband Service chosen.  To find 
a listing of all available 4G/3G Modems please visit the following site: 
http://www.cradlepoint.com/compatibility.

•	What	are	the	Choices

◊  Enables internet access through 4G/3G wireless broadband 
networks, existing WiFi, or Ethernet -based data services ( 
Cable / DSL / Satellite )

◊  Supports most wireless data modems from the leading carriers 
( modem and service sold separately )

◊  Special Feature:  Use WiFi as a Data Source.

Your PhotoBooth comes pre-installed with a CradlePoint CTR35 Router which 
makes it easy to get your PhotoBooth Internet Access using 1 of 3 different choices.   
To configure you’re CTR35, you must connect a keyboard and mouse to the com-
puter of your photo booth (Note:  Both of these devices must be disconnected after 
configuring the router to use the PhotoBooth).

Important: Please follow these instructions step-by-step.  If you are using a 4G/3G Wireless 
Broadband mode, please ensure it is listed as a Cradlepoint-supported device by visiting 
http://www.cradlepoint.com/products/mobile-broadband-routers/ctr35-wireless-n-portable-router.

Network	Connectivity

Wireless or Wired Internet Access

http://www.faceplacephoto.com
http://www.cradlepoint.com/compatibility
http://www.cradlepoint.com/products/mobile-broadband-routers/ctr35-wireless-n-portable-router.
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Step 1: Accesing the web browser.

Step 2: Using the first time setup wizard

To access the CradlePoint CTR35 Administration Page you will need to do 
the following:

If this is the First Time you are connecting to the CradlePoint, the First 
Time Setup Wizard will help you customize the name of your wireless 
network, change passwords to something you choose, and establish an 
optimal WiFi security mode. The CTR35 comes with a unique password 
creating built-in WiFi Security, which prevents unauthorized users from con-
necting to your WiFi network.

1.  Connect a USB Keyboard & USB Mouse to the Front USB Ports of the Pho-
toBooth computer.

2.  At any point while “attract mode” is playing, tap the six o’clock position on 
the monitor.

3.  Hit the ESC Key on the Keyboard to close the PhotoBooth Application.

4.  Click the Start Menu->Programs->Internet Explorer to launch Internet 
Explorer.

1.  If you have chosen to go with a Wired Connection, you will need to bring 
an Internet Accessible Ethernet Cable into the PhotoBooth using one of 
the Pass-Through Holes on the Cabinet.  (On some cabinets it may be 
necessary to drill a Pass-Through Hole if one is not available).

2.  You will need to disconnect the Ethernet Cable that comes pre-installed 
between the CradlePoint CTR35 and the PhotoBooth computer from the 
computer.

3.  Connect the Internet Accessible Ethernet Cable that you have at the 
location into the PhotoBooth computer.  

4.  Your PhotoBooth should now have Internet Access.

If you have chosen WiFi as WAN or 4G/3G Wireless Broadband Connection 
you will need to configure the CradlePoint CTR35.  Before getting started, if 
you are using WiFi as WAN, please ensure that you have the WiFi SSID and 
Password for the WiFi Network you will be connecting to.  If you will be using 
a 4G/3G Wireless Broadband Modem, install the Modem into the USB Port of 
the CradlePoint CTR35 before continuing.

•	Are	you	using	a	wired	connection?

•	Are	you	using	WIFI	as	WAN	or	a	4G/3G	Wireless	Broad-
band	Connection?

http://www.faceplacephoto.com
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Step 3: Modem support & updates

CradlePoint regularly makes new modem support and performance en-
hancements available in a software package called “firmware”. Updating 
firmware ensures your CradlePoint CTR35 will run reliably and have the latest 
3G/4G Broadband Network Modem Support as new modems are released.

1.  In the Internet Explorer address bar  type “cp” or “192.168.0.1” (without 
quotation). Press ENTER/RETURN.

2.  Enter your password to login. Your unique password is either the admin-
istrator password you set earlier or the default password found on the 
bottom label of the CTR35.

3.  Select SYSTEM SETTINGS on the top navigation bar, then SYSTEM 
SOFTWARE in the drop down menu.

To update your firmware, follow the steps below.

•  If you are currently using the CTR35 WiFi network, 
reconnect your devices to the network using the new 
wireless network name and security password.

1.  In the Internet Explorer address bar  type “cp” or “192.168.0.1” (without 
quotation).  Press ENTER/RETURN.

2.  When prompted for your password, type the eight character Default 
Password found on product label.

3.  When you log-in for the first time, you will be automatically directed to the 
FIRST TIME SETUP WIZARD.

STEP A

If you choose, you can change the router’s ADMINISTRATOR PASSWORD.
Then, select your TIME ZONE. Click NEXT.

STEP B

CradlePoint recommends you customize your WiFi Network Name. Type in 
your Personalized Wireless Network Name here. 

Choose the WIFI SECURITY MODE that best fits your needs: POOR for WEP, 
GOOD for WPA/WPA2 and BEST for WPA2 Only. (Make sure your PC or other 
devices support the mode you choose). Choose a personalized WIRELESS 
SECURITY PASSWORD. This password will be used to reconnect your devices 
to the router once the security settings have been saved. Click NEXT.

STEP C

If necessary, select your 4G WiMAX Realm. If you have a 3G or LTE 
modem, no Selection is necessary. Click NEXT.
STEP D

Review the details and record your wireless network name,  administrative 
and wireless password. Clicks APPLY to save the settings to your router.
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Step 4-1: If you are using WIFI as WAN

1.  In the Internet Explorer address bar  type “cp” or “192.168.0.1” (without 
quotation). Press ENTER/RETURN.

2.  Enter your password to login. Your unique password is either the admin-
istrator password you set earlier or the default password found on the 
bottom label of the CTR35.

3.  Click Mode Button to Toggle to Advanced Mode.

4.  Click Internet.
5.  Click WiFi as WAN.

6.  Select WiFi as WAN Button to Activate WiFi as WAN

7.  Under Site Survey, select the WiFi network you wish to use by checking the 
box next to it.

4.  Find the FIRMWARE UPGRADE section. This will display the current 
firmware version that is installed and indicate if updated firmware is 
available.

5.  Click AUTOMATIC (Internet) if new firmware is available. The router will 
download and install the firmware and automatically reboot itself. A status 
monitor will appear and indicate when this process is complete. This 
process may take several minutes depending on your internet connection 
speed.

6.  If your router does not have an active internet connection (ie: modem not 
working on older firmware) you will need to download the latest firmware 
from http://www.cradlepoint.com/firmware/ctr35 to your desktop, and 
then use the MANUAL FIRMWARE UPLOAD option.

http://www.faceplacephoto.com
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At this point, you need to close your web-browser, check to see if you’re 
still connected to your router, if you are not, connect back to it again.  Open 
a web-browser again after you are connected to the router; if you are not 
able to get through to the Internet, login to your router’s admin pages again, 
go to Status -> Router Console, where you see “Internet,” check to see the 
status of your connection.  NOTE: it can take several minutes to establish the 
connection with the network you are using.

Step 4-2: If you are using a 3G/4G broadband network

It is important that when selecting a 3G/4G Broadband Network for your 
location that you verify that signal strength of the Wireless Provider is 
adequate for Data Transfers at the location for your selected provider. If your 
primary provider doesn’t have good signal strength at the location you will 
need to look into an alternative 3G/4G provider or look into one of the two 
other options for connecting your device. We also highly recommend that 
an External High Gain antenna be used when possible to ensure the highest 
quality of signal.

8.  Click Import.

9.  If the network you wish to use is secured, you will need to enter the 
Password in the screen that comes up relating to that specific network.  
Whether you have to enter a security password or not, click Submit on that 
screen that shows up.

10.  If the Wifi-as-WAN network was successful in importing, you will see a 
Green Dot next to Internet Connections at the top of the Administration 
Page.
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Step 5: Setup system automatic reboots

It is recommended that you enable System Automatic Reboots to allow for 
the device to have a Daily Reboot.

1.  Verify 3G/4G Broadband Network USB Modem is plugged into the Cradle-
Point USB Port.

2.  In the Internet Explorer address bar  type “cp” or “192.168.0.1” (without 
quotation) in the address bar. Press ENTER/RETURN.

3.  Enter your password to login. Your unique password is either the admin-
istrator password you set earlier or the default password found on the 
bottom label of the CTR35.

4.  If 3G/4G Broadband Network USB Modem has successfully connected, you 
will see a Green Dot next to Internet Connections at the top of the Admin-
istration Page.

1.  In the Internet Explorer address bar  type “cp” or “192.168.0.1” (without 
quotation). Press ENTER/RETURN.

2.  Enter your password to login. Your unique password is either the admin-
istrator password you set earlier or the default password found on the 
bottom label of the CTR35.

3.  Click Mode Button to Toggle to Advanced Mode.
4.  Select SYSTEM SETTINGS on the top navigation bar, then SYSTEM 

CONTROL in the drop down menu.

5.  Set Scheduled Reboot to Daily.

6.  Set Time to a Time when the PhotoBooth will not be used as you do not 
want the CradlePoint to reboot during the PhotoBooths normal operation.

7.  Ensure that Enable Watchdog Reboot is Checked.

8.  Select Apply.
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Step 6: Setup Failure checks

It is necessary that you enable Failure Checks to ensure that the Cradle-
Point reestablish an Internet Connection if it loses its connection to the 
Internet.  

1.  In the Internet Explorer address bar  type “cp” or “192.168.0.1” (without 
quotation). Press ENTER/RETURN. There is a shortcut called “Cradle point 
administration console” in the Start menu of Windows to get this easily.

2.  Enter your password to login. Your unique password is either the admin-
istrator password you set earlier or the default password found on the 
bottom label of the CTR35.

3.  Click Mode Button to Toggle to Advanced Mode.

4.  Click Internet.
5.  Click Connection Manager.

6.  In Connection Manager click your device under WAN Interfaces and hit 
Edit.

7.  Click Arrow to Right of Failure Check to open Advanced Options.

8.  Set Idle Check Interval to 30 seconds.

9.  Set Monitor while connected to Active Ping.

10.  Set Ping IP Address to 4.2.2.2.

11.  Click Submit.
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Additional help

For additional how-to documents and support with your CradlePoint CTR35 
when utilizing the WiFi as WAN or 3G/4G Broadband Network Option, please 
visit the CradlePoint Support Site at http://www.cradlepoint.com/CTR35.

http://www.faceplacephoto.com
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LogMeIn Free is a basic remote control utility for accessing your PC or Mac, 
which can be used to Remotely Administer a Face Place Photo Booth. For full 
remote access, including file transfer, remote printing and file sharing, you 
may want to try LogMeIn Pro.

Compare LogMeIn Free to LogMeIn Pro

LogMeIn Free includes:

◊  Access from any Internet-connected web browser.

◊  Access to a Windows PC or Mac.

◊  Remote control and desktop viewing.

◊  Copy and paste between computers.

◊  Wake on LAN.

◊  Reboot/reconnect (including safe mode).

◊  Basic reports (remote access sessions and user access).

◊  Chat.

◊  AES 256-bit encryption.

◊  SSL/TLS intrusion detection.

◊  IP address lockout.

◊  No need for firewall, router or proxy configuration.

◊  No requirement for remote PC admin rights.

We will help you get LogMeIn Installed on a Face Place Photo Booth so that 
you can begin Remotely Monitoring and Administering your Face Place Photo 
Booth.

Visit the LogMeIn Free Registration Page at https://secure.logmein.com/
products/free/register.aspx and sign up for your free account. 

Log into your newly created LogMeIn Account at https://www.logmein.com 
and select the Add Computer button to access the New Computer Screen. 
If prompted to select a Subscription Type, select the Subscription Type that 
fits your needs and follow any on screen instructions.

Download the Installation File to a USB Flash Stick and remove the USB 
Flash Drive.

•	Introduction

•	Register	for	LogMeIn	Free

•	Downloading	LogMeIn	Installation	File

Remote	Access

http://www.faceplacephoto.com
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•	Install	LogMeIn	on	Face	Place	Photo	Booth
1.  Shut Down Photo Booth.

2.  Connect a Keyboard & Mouse to Photo Booth CPU

3.  Connect USB Flash Drive to Photo Booth CPU.

4.  Power on the Photo Booth and Allow Photo Booth to fully Startup. 
 
NOTE: The Photo Booth must be connected to an active internet 
connection. 

5.  Close the Photo Booth Application by clicking the Message Area and hitting 
ALT+F4 on a Keyboard.

6.  Open Windows Explorer by Selecting Start->My Computer.
7.  Double Click E Drive to Explore USB Flash Drive.

8.  Double Click the LogMeIn Installation File you downloaded to run Installer.

9.  Select Run if prompted by a Windows Open Dialog Box.

10.  Click Next to Start Installation. 

11.  Click Next to Continue Installation.

http://www.faceplacephoto.com


Section - Remote Access

Apple Industries Inc. - Service Manual www.faceplacephoto.com Page 42

13.  Select Typical (recommended) and Click Next to Continue Installation.

14.  Enter Description in the following format: Operator Name – Location 
Name (ie. Amusement Inc – Pizza Shack NY).

15.  Click Next to Continue Installation.

12.  Click I Agree to Continue Installation.
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16.  Select an Access Code and enter in both textboxes. (Please ensure that 
you remember this Access Code).

17.  Click Next to Continue Installation.

18.  Click Next to Continue Installation.

19.  Select Launch LogMeIn when finished and Click Finish to Finish Installation.
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•	Configure	LogMeIn	for	use	alongside	Photo	Booth

It is necessary to configure LogMeIn exactly as described below so that 
the LogMeIn Application does not interfere with the Face Place Photo Booth 
Application.

1.  Select Options->Preferences

2.  Unselect the following options in General Tab:

◊  Use display accelerator
◊  Lock when connection has been lost
◊  Lock when connection has been timed out 
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•	Connecting	to	Photo	Booth	using	LogMeIn
Connect to any computer that meets these conditions:

◊  LogMeIn Pro or Free must be installed and running on the host.
◊  The host must be turned on.
◊  The host must be connected to the Internet.
◊  The host must not be in Sleep mode or Hibernation mode.

Tip: If the host computer is on a network with other LogMeIn host 
computers then you may be able to wake it usingWake On LAN. To 
review Wake On LAN requirements, see How to Wake a Computer in Sleep 
Mode or Powered Off Using Wake On LAN.

3.  Unselect the following options in Advanced Tab:

◊  Download and install updates automatically

4.  Click OK to Save Settings

5.  Remove the USB Flash Stick, Keyboard, & Mouse.

6.  Restart the Photo Booth.

7.  LogMeIn is now properly installed & configured.

http://www.faceplacephoto.com
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To connect:

1.  Go to www.LogMeIn.com.

2.  Log in to your account using your LogMeIn ID (email address) and 
password. The Home page is displayed.

3.  On the Home page, click a connection option for the computer you want to 
access.

Tip: Control-click or middle-click to open the session in a new 
browser tab. On a Mac, use Command-click.

◊  Click the Main Menu link to connect to the host Main Menu 
(also known as Compact View) for basic remote access func-
tionality.

◊  Click the computer name to start controlling the host’s desktop.

◊  Windows hosts only. Click Dashboard to connect to the host 
Dashboard (also known as Detailed Mode) for access to 
advanced remote management functionality.

◊  Click File Manager to go directly to the host File Manager.

◊  In List View, click the blue arrow next to the computer you want 
to remote control and click Remote Control in new window to 
open the session in a new window or browser tab.

LogMeIn will attempt to make a connection to the host. You will be 
prompted to authenticate to the host.

4.  Log in to the computer using the appropriate authentication method:

◊  If prompted, enter the username and password you would 
enter if you were sitting in front of the host computer.

◊  If prompted, enter the Computer Access Code you created 
when you installed LogMeIn to the host computer.

Your session begins upon successful authentication.

Important: The first time you start a remote control session you 
will be asked to install a browser plug-in to the client computer, 
which is the computer you are using to initiate the remote session.

http://www.faceplacephoto.com
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•	Starting	Remote	Control

Click the name of the computer you want to control to go directly to 
remote control.

From the Home page

Once connected to the host, click Remote Control on the left menu to 
start remote control.

From the Host Main Menu

Choose the most convenient way to gain control of a host computer.

Available on Windows hosts only.

Once connected to a Pro host, go to the Dashboard (Detailed mode) and 
click the Remote Control icon (not the text). Select a remote control client 
from the list.

From the Host Dashboard
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Once you have launched remote control and successfully authenticated to 
the host computer, you see the host computer’s desktop and the LogMeIn 
remote control toolbar.

Once Connected

Complete step-by-step instructions are available in the LogMeIn Free User Guide.

Sample remote control toolbar for LogMeIn Pro.

•	Working	with	the	Photo	Booth	using	LogMeIn

Once Remote Control is started, it is recommended that you blank the 
screen of the Photo Booth using the Options->Blank Screen Option. When 
Blank Screen is enabled, the Photo Booth monitor will be blank while you are 
connected which will prevent users from seeing what you are doing and your 
access codes.

NOTE: If this is the first time enabling Blank Screen, you will need 
to install the Plug-In on the Photo Booth. Select Install to allow the 
Driver to install. Once the Driver has been successfully loaded a 
dialog box will be displayed that you must select OK.

http://www.faceplacephoto.com
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It is recommended that you lock the keyboard/mouse of the Photo Booth 
using the Option->Lock Keyboard option.

You can now use your mouse to work with the Photo Booth like you were 
at the booth using the touchscreen. You can pull up the Access Keyboard by 
clicking at the bottom center of the screen like you would normally use your 
finger when at the booth.

NOTE: You MUST use the on-screen keyboard whenever it is 
displayed to enter items within the Configuration Application. If you 
use your physical keyboard the proper settings may not be saved 
and you could corrupt the Photo Booth Configuration causing your 
Photo Booth to not operate properly.
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1.  USB Extension cable.

2.  I/O Board.

3.  Internet Cradlepoint router.

4.  Printer.

5.  USB Hub.

6.  Audio connector (Green one).

7.  Monitor.

8.  S video.

9.  Power cord.

•	PC	Computer	connections

Hardware	(Specific)

•  Below is an illustration of where connec-
tions should be made, your actual ma-
chine may not have connections in the 
same position

1 2 3 4 5 6 7 8 9
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1.  Computer.

2.  Printer.

3.  Power Supply.

4.  I/O Board

5.  Cradle Point.

6.  Kiosk Amp.

7.  Camera.

8.  Monitor.

9.  4 Port USB Hub. (Monitor, CCreader, 
microphone, ...).

5

4

3

2

6

1

9

8

7
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•	Equipment	characteristics

Shipping weight Design type Construction

Approx. 850lbs. (385.55kg.). Coin-operated
photo booth.

Powder-coated,
sheet steel.

System Peripherals

• 1 PCB, Intel microcontroller-
based.

• Windows (OS).
• OS & application PC.
• I/O control board.
• Credit card reader ( optional).

• 1 Mitsubishi digital printer CP9550DW-A.
• Digital sound system.
• Sony Digital Camera FCB-IX47C/IX45CP or FCB-

IX47C/IX47C.
• LCD Touch Screen  Monitor.
• Dollar Bill Validator.
• On Screen Diagnostic and settings.

Operator variables

• Pricing.
• Logo.
• Color Adjustments.
• Backgrounds.
• Sound volume.

• Date & Time.
• Lighting.
• Programs.
• Real-time picture 

quality. 
• Program Choices on/

off.

The Mitsubishi CP9550DW-A is a dye sublimation thermal, photographic 
quality printer. The printer produces fast, high-resolution black and white 
and color photographs for indoor, self-service applications. The photo booth 
computer sends digital image data to the printer. Output is two four-image, 
two-by-six-inch photo strip and 4x6 photos. Each image is two inches x one 
and a half inches. From exposure to vend, per-strip turnaround time is about 
17 seconds.

•	Printer	description

•	Operating	requirements

Power supply AC 120V 50/60Hz

Power comsuption 3.5A
(AC 120V, 50/60Hz).

Operating condition Temperature:
5-40 ºC (41-104 ºF

Humidity
30-80% (No dewing)

Hardware	generic
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Ink sheet. Turn on the power, then press the 
Door Open button.

Lower the tray. Pull the tray out.

•	Loading	media	(Film	and	paper)

Ink ribbon installation

English Français

•  AVOID BURNS AND HEAD DAMAGE! 
Don’t touch the print head.

•  Only use Mitsubishi FP2000 media (Apple 
Industries part # FP2000) in the printer. 
Other media will cause the booth not to 
work and may cause printer, PC and con-
trol board damage. Using other paper will 
void your warranty.

•  ÉVITEZ DES BRÛLURES ET DU 
DOMMAGE À LA TÊTE D’IMPRESSION. 
Ne touchez pas la tête d’impression.

•  Seulement utilisez média Mitsubishi 
FP2000 (pièce d’Apple Industries n° 
FP2000) dans l’imprimante. Usage d’autre 
média causera le mal fonctionnement du 
photomaton et peut causer du dommage 
à l’imprimante, à l’ordinateur, et à la carte 
de contrôle. Usage d’autre papier annulera 
votre garantie.
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Final position.

Push the tray up, you will hear a click 
when the tray is in the correct

position.

Ink ribbon installation

Lift up roll at front.

Tighten the sheet. Insert the tray

Supply roll at back, ribbon comes 
from bottom to top.
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Drop it into the slot.

Paper roll assembly

Paper loading

Take out the parts from the box.

Insert it into the paper roll. Insert the other part into the paper 
roll.

Squeeze the two notches towards 
center.
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When the door is closed. Printer will automatically feed and 
cut three times.

Paper feeding mechanism

Insert the cartridge.

Paper edge needs to reach the black 
cover.

Close the door.

Insert between the metal and black 
rubber roller.
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•  Store paper in a dark and dry place. Never store print paper in 
places that are hot humid or exposed to direct sunlight. Tem-
peratures must be between 55°F (13°C) and 90°F (32°C). 

•  Fingerprints or dust on the papers surface  may degrade  print 
quality  and cause paper jams.

•  The paper and ink ribbon are made of plastic. When you dis-
pose of them, follow local regulations concerning disposal.

Transportation requirements

1.  Remove paper.

2.  Remove ink sheet but leave empty tray in.

3.  Close the door.

4.  Wait until the paper/ink ribbon green LED starts blinking.

English Français

•  Only use Mitsubishi FP2000 media (Apple 
Industries part # FP2000) in the printers. 
Other media will cause the photo booth not 
to work and may cause printer damage. 
Using other media will void your warranty.

•  Every time you replenish media, remove 
any paper scrap remains from inside the 
machine. This buildup of paper scrap pos-
es a fire hazard.

•  Seulement utilisez média Mitsubishi 
FP2000 (pièce d’Apple Industries n° 
FP2000) dans l’imprimante. Usage d’autre 
média causera le mal fonctionnement du 
photomaton et peut causer du dommage 
à l’imprimante. Usage d’autre média 
annulera votre garantie.

•  Chaque fois vous remettez du papier, 
enlevez le papier résiduel de la machine. 
Débris de papier pose un risque d’incendie.
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Instructions:

1.  Connect your photo booth to the internet (See Network Connectivity 
section of this manual for instructions).

2.  Perform a “test” swipe with a credit card, you should see a green light il-
luminate on the card reader.

3.  Call or email USA Technologies to setup your merchant account (Note:  You 
will need the serial number from your credit card reader, which is listed 
in the electronic meter report for your photo booth—See Meter Reports 
section of this manual for more information).

Apple Industries (Apple) has teamed with USA Technologies (USAT) 
as the merchant service provider for your card reader equipment.  
They are responsible for the processing of credit/debit transactions 
of your photo booth equipment, and the suite of services associated 
with card reader functionality.  When you are ready to move forward 
with credit/debit card acceptance, USAT will need to setup a merchant 
account for your company.  To do this, please contact USA Technolo-
gies at customerservice@usatech.com or call their toll free number 
at 1-888-561-4748.

•	Credit	Card	Reader	Activation	Instructions

Credit	card	activation	(If	installed)
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Be sure that you load the paper properly. Clean the printer at least once a 
year. Regularly check that the print.

1.  Spray plastic or glass cleaner on a lint-free, non-abrasive wipe. This 
cleaner is for the window only. Never use it directly on the camera lens! 

2.  Gently wipe dust and dirt off the camera window inside the booth. Use a 
straight-across motion, rather than a circular motion. Don’t scrub over 
stubborn dirt.

3.  Inspect the glass for cracks. Scratches and gouges that may degrade 
images. 

◊  Feeds paper properly.

◊  Operates as it did when new.

◊  Makes no abnormal sound.

◊  Produces outstanding print quality.

•	Printer	inspection

Periodically check the entire booth. Your profits depend on booth cleanli-
ness and booth performance. A shabby, malfunctioning booth can’t mer-
chandise itself as well as a properly maintained booth can. Upkeep is the 
only way to assure that the booth can earn for you. Regularly check that the 
booth…

◊  Has plenty of paper. Use only Apple Industries FP2000 media 
(Apple Industries part # FP2000). Be sure that you load it 
properly. 

◊  Stacker is installed and empty at the beginning of every 
business day. 

◊  Seat is clean.

◊  It is clean and free from graffiti, stains and scratches. Replace 
or refurbish worn-out graphics and surfaces. 

◊  Pricing and vending options are up to date and competitive.

◊  Bill validator operates properly and doesn’t stick, jam or 
otherwise malfunction.

◊  Camera lens window is clean, graffiti-free and unscratched.

◊  Fluorescent Light Bulbs all operate properly.

◊  Rapidly exposes and prints splendid, snappy images with a full 
tonal range.

•	Booth-Wide	inspection

•	Camera	window	cleaning

Maintenance
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The following tips will help keep your touchscreen functioning at the 
optimal level.

◊  To avoid risk of electric shock, do not disassemble the brick 
power supply or display unit cabinet. The unit is not user ser-
viceable. Remember to unplug the display unit from the power 
outlet before cleaning

◊  Do not use alcohol (methyl, ethyl or isopropyl) or any strong 
dissolvent. Do not use thinner or benzene, abrasive cleaners or 
compressed air.

◊  To clean the display unit cabinet, use a cloth lightly dampened 
with a mild detergent.

◊  Avoid getting liquids inside your touchscreen. If liquid does get 
inside, have a qualified service technician check it before you 
power it on again.

◊  Do not wipe the screen with a cloth or sponge that could 
scratch the surface.

◊  To clean the touchscreen, use a window or glass cleaner 
that does NOT contain ammonia. Put the cleaner on a clean 
cloth and wipe the touchscreen. Never apply the cleaner 
directly on the touchscreen.

•	Care	and	handling	of	your	touchscreen

1.  Turn off booth power.

2.  Open the service door.

3.  Use a nut driver.  Gently pull and replace  the  Fluorescent Light Bulbs.

4.  Fasten diffuser holder. 

5.  Bulbs are accessible once door is removed.

6.  Gently pull and replace.

7.  Close service door, remove key.

8.  Turn on booth power and verify normal lamp operation. 

1.  Turn off booth power.

2.  Two nuts secure the dome lamp to the booth roof. The screws for these 
nuts are on the ceiling of  the Seat Unit. (Note a third screw that secures 
the lamp flange under the lamp diffuser. Avoid loosening this screw.) Use a 
screwdriver and nut driver to remove dome lamp screws and nuts. 

3.  Remove the lamp diffuser. 

4.  Replace the LED strip. Your replacement should be 12vDC LEDs.  Call Apple 
for exact replacement part.

5.  Before replacing the reflector, be sure that the lamp socket flange is tight. 
If it’s loose, tighten it.

6.  Replace the lamp diffuser.

7.  Use a screwdriver and nut driver to secure dome lamp reflector screws and 
nuts. 

8.  Turn on booth power and verify normal lamp operation.

•	Replacing	Fluorescent	Light	Bulbs

•	Replacing	the	dome	lamp	(If	applicable)
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Built in pattern print for Mitsubishi CP9550DW-A.

•	Printer	test

Troubleshooting

•  Periodically check the booth by inserting 
bills, taking a picture and observing the 
vended product.

•  Repair or replace anything that isn’t as 
good as new. 

1.  Turn off printer power. 

2.  While holding down: Door Open and Feed/Cut buttons, turn printer on.

3.  Continue to hold buttons until you hear a beeping sound, then release 
them.

4.  Press the Cancel button (must hear a beeping sound and release).

5.  In approximately ten seconds you should see the Data LED turn on, it will 
now print the test pattern.

English Français

For test purposes, you can isolate a printer 
from the rest of the system. When testing, run 
the printer directly off an AC power source.

Pour des essais, vous pouvez isoler une 
imprimante du reste du système. Pendant les 
essais, branchez l’imprimante directement 
dans une source d’alimentation c.a.

http://www.faceplacephoto.com


Section - Troubleshooting

Apple Industries Inc. - Service Manual www.faceplacephoto.com Page 62

Troubleshooting Tables guide you to appropriate remedies based on 
photo booth malfunctions. The idea is to think of each malfunction or indica-
tion as a symptom. A symptom usually isn’t the problem, and you shouldn’t 
treat the symptom as the problem. Many problems produce more than one 
symptom. Some of these symptoms may be misleading. Together, all the 
symptoms generally suggest one or more causes. Each cause associates with 
a treatment procedure.  

Start troubleshooting by finding your booth’s symptom on the tables. By 
testing and considering each cause, you’ll find one or more that seem more 
likely. The Troubleshooting Tables should help you to narrow down the pos-
sibilities and take corrective action. 

•	Using	troubleshooting	tables

SYMPTOM CAUSE REQUIRED ACTION
No illumination, no obvious sign 
of operation.

• No AC power
• Open Fuse

• Check that booth is plugged in.
• Check that booth power switch 

is on.
• Check BREAKER located on 

Power strip and switch 

Machine lights up, monitor 
flashes brand logo then there is 
no activity on the screen.

• No power to the computer. • Check to see that the power 
cord that plugs into the com-
puter is snug in the socket on 
the PC.

• Check to see that the PC has 
not shut itself off.  Press the 
power button on the front of 
the PC case.

• Replace the power supply 
inside the computer case.  Call 
customer service to obtain a 
new one.

Machine lights up, LED’s on 
computer case illuminate, after 3 
minutes or so the DBA lights illu-
minate and blink. Monitor brand 
logo does not appear.

• Monitor has no power or has 
shut itself off during transport.

• Check to see that the power 
cord and the vga signal cable 
to the monitor is connected to 
the back of the monitor.

Camera
SYMPTOM CAUSE REQUIRED ACTION

Live image on screen is blurry 
and resulting prints are blurry as 
well.

• Dirt and debris on camera 
glass.

• Spray glass cleaner on paper 
towel and clean glass on both 
sides. If problems persists 
closer examination is neces-
sary, often the cause can be 
detected by studying the blurry 
print and find the object that 
the camera is focusing on.

Meter report error displayed Cause of error Possible solutions
No email address has been en-
tered. Please enter email address 
in Configuration Reports section.

• Operator has attempted to 
send an email from the Meter 
Report but no Email address is 
configured in the Configuration 
Application.

• Open Configuration Application 
and enter email address under 
Configuration Reports section.
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Printer
SYMPTOM CAUSE REQUIRED ACTION

Machine comes up and after the 
the photobooth load a message 
appears at the end of the startup 
that says “Fatal Printer Error…
Check connections and reboot“.

• Printer is unplugged or off.
• Printer is in a state of alarm.

• Check to see if the printer 
power and ready LED’s  are lit.

• Correct source of alarm (paper 
jam etc).

Machine comes up and after the 
the photobooth loads a message 
appears at the end of the startup 
that says “Unsupported Media 
Type”.

• Incorrect media loaded in 
Printer.

• Make sure that you have load-
ed into your printer GENUINE 
Apple Industries Print media 
specific to your machine.

• The Apple Photo 2 Go uses 
FP2000.

User interface error displayed Cause of error Possible solutions
Problem starting Photobooth. 
Please notify the Operator.

• Fatal Photo Booth Error during 
Startup Diagnostic Checks.

• Check I/O board is properly 
connected and powered up if 
not on Free Play.  

• Check that Credit Card Reader 
is properly connected if not on 
Free Play.  

• Check that the camera is 
properly connected to all con-
nections (Serial & S-video) and 
powered up.

Printer is not found. Check USB 
or Power On.

• Printer is not found. • Check printer is properly con-
nected, powered on and ready.

The printer door is open. Close 
the door.

• Printer door is open. • Close the printer door.

There is no sheet. New media 
(Ink & Paper).

• Media is missing from Printer. • Insert the Apple-provided 
media into the printer. (Ink & 
Paper).

Print Error. • The Printer failed as printing. • Check printer is properly con-
nected, powered on and ready.

No faces detected. Please look 
at the camera and try again. Or 
select a different theme.

• A theme requiring Facial 
Detection (Face Replacement, 
Crazy Hair, Postcard & Passport 
Style) was selected but the 
user did not look at the camera 
for all pictures.

• Have the user look at the cam-
era for all pictures or select 
a theme that doesn’t require 
facial detection.  (Classic, Fun 
Borders, Holiday Borders).

Could not share with Facebook. 
Check username and password.

• Unable to share with Facebook. • Have the user verify their 
Facebook credentials are cor-
rect.

• Verify that the Photo Booth is 
properly online and connected 
to the internet.

An error occurred. Please try 
again.

• The camera has stopped com-
municating with the Photo 
Booth.

• Check that the camera is 
properly connected to all con-
nections (Serial & S-video) and 
powered up.
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If problems persist, please contact our technical support at (516) 619-8000 during 
business hours. (8 am to 5 pm Eastern Time.)

Configuration error displayed Cause of error Possible solutions
Email cannot be sent at this 
time.  Please check internet con-
nection.

• Operator has attempted to 
send an email from the Meter 
Report but no internet access 
is established.

• Verify the booth is properly 
online and connected to the 
internet and try again.

Cannot disable CC Reader while 
free play and dollar bill validator 
(DBV) are disabled.

• At least one payment method 
must be enabled when not on 
Free Play.

• Either enable Free Play or en-
able the DBV.

Cannot disable DBV Reader while 
free play and CC are disabled.

• At least one payment method 
must be enabled when not on 
Free Play.

• Either enable Free Play or en-
abled the CC.

Cannot disable free play while 
DBV and Eport are disabled.

• At least one payment method 
must be enabled when not on 
Free Play.

• Either enable DBV or CC before 
attempted to disable Free Play.

Cannot disable Color/B&W/
Sephia while Custom strip con-
tains Color/B&W/Sephia.

• The operator has attempted 
to disable either Color, B&W or 
Sephia while the Custom Strip 
contains that program choice.

• Remove all instances of pro-
gram choice from Custom Strip 
setup prior to disabling.

Invalid action.  Must set a pro-
gram to default.

• The operator has attempted 
to remove the default option 
from a program while no other 
programs are set to default.

• One program has to be set as 
default.  Have the operator 
select another program as the 
default program.

No email found. • Operator has attempted to 
send Email Captures but no 
Email addresses are currently 
captured.

• Try again later after email ad-
dresses have been captured.

Unable to connect to Facebook.  
Try again or check credentials.

• Operator has attempted to add 
credentials to Facebook Batch 
but unable to connect with 
Facebook.

• Have the operator verify their 
Facebook credentials are cor-
rect.

• Verify that the Photo Booth is 
properly online and connected 
to the internet.

Unable to Post Media to Face-
book.  Try again or check creden-
tials.

• Operator has attempted to 
send to Facebook Batch but 
unable to connect with Face-
book because user credentials 
are incorrect.

• Have the operator verify their 
Facebook credentials are cor-
rect.

Facebook unavailable, please 
check internet connection.

• Operator has attempted 
to send to Facebook Batch 
but unable to connect with 
Facebook because there is no 
internet connection.

• Verify that the Photo Booth is 
properly online and connected 
to the internet.
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APPLE INDUSTRIES, INC.
WARRANTY POLICY

All parts (except for light bulbs and cabinet wheels) are under Warranty against actual defects in 
material and workmanship under normal and customary use for a period of one year from the date of 
purchase. This Warranty does not include labor, unless the defect occurs Within 30 days of purchase. 
The customer is responsible for the inbound freight of items sent in for Warranty repair. The customer 
must call customer service for an RMA on all returns. There is no charge for utilizing our telephone 
technical assistance, which is available 8:00 am-5:00 pm EST Monday-Friday, except holidays.

Apple may, in its discretion, provide an advance exchange of parts under Warranty. In the event that 
an advance exchange of parts is provided by Apple, regular ground shipping (U.S. only) of the new 
parts will be provided by Apple, at no cost to the customer. Any special shipping requests are the 
responsibility of the customer. Shipping to return the defective parts is the sole responsibility of the 
customer. All such defective parts must be returned within 15 calendar days after receiving the new 
replacement parts. If the defective parts have not been returned by the customer within the 15 calendar 
days, or if any of the parts are deemed not defective or otherwise not under warranty, no credit will 
be issued, the advance replacement will be considered a final sale and Apple will charge customer’s 
credit card accordingly. Apple may require customer’s credit card as a condition to an advance ex-
change of parts.

This Warranty shall be null and void if the equipment has been tampered with or serviced by a person 
not authorized by Apple to perform the service.

ANY IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION THE IMPLIED WAR-
RANTIES OF MERCHANTABILITY AND FITNESS FOR A  PARTICULAR PURPOSE, ARE 
EXPRESSLY DISCLAIMED. THIS EXPRESS LIMITED WARRANTY IS THE EXCLUSIVE 
REMEDY OF THE CUSTOMER, AND IS PROVIDED IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESS OF IMPLIED. IN NO EVENT SHALL APPLE OR ANY OF ITS RELATED COMPA-
NIES BE LIABLE, WHETHER IN CONTRACT OR TORT (INCLUDING NEGLIGENCE) FOR 
DAMAGES IN EXCESS OF THE PURCHASE PRICE OF THE PRODUCT, OR FOR ANY INDI-
RECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR LOSS 
OF REVENUE OR PROFITS.

IMPORTANT SAFETY WARNING
Disclaimer:  Apple Industries/Face Place shall not be liable or responsible for any damages result-
ing from the handling,  use or operation of its  photo booths.  With your purchase, the buyer confirms 
that you have read and understand the following warnings and you agree that you are responsible for 
all damages and injuries caused by the handling, operation or use of the photo booths, which include 
any personal injuries.  The Face Place Deluxe: Theme Park Edition photo booth is designed as a 
weather resistant photo booth capable of being left outdoors  under normal weather conditions.  It 
is not designed for nor shall it be used during inclement weather events including rain, high winds, 
thunderstorms, snow, extreme heats (in excess of 100 degrees Fahrenheit), or cold (below 50 degrees 
Fahrenheit).  If such inclement weather  conditions occur, the photo booth’s operation should cease 
immediately and the photo booth should be thoroughly inspected  prior to resuming operation.
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